Using Excel to
Troubleshoot EMIS Data

Alliance



- Overview

* Basic Excel techniques can be used to analyze EMIS data
from Student Information Systems (SISs), from the Data
~ Collector, and on ODE EMIS reports
S

» * This session will demonstrate Excel functions and practical
- applications that can be helpful in all phases of the EMIS
data review process



Outline

 ODDEX Student Cross Reference (SCR) Export
* Calendar and Student Data Comparison

e Staff Data
 FTE Detalil
 FTE Detalil

Formatting to Share with District Staff
Report Subtotaling

Report PivotTable
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ODDEX SCR Export
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ODDEX SCR Export Text File

Ohio | ctemmm O

. Choose to “Exclude Inactive”
A or “Exclude Hidden” records

Home SOES SCR History CCP Tuition Calendar Users Agencies

Last Name SSID Sedans Exclude Inactve /
A %

In the SCR, select a

“Display Mode” and

Select “Export”
“Find” and the students

generate a text file

will appear below

SSio Last Name First Name Birth Date Conflict Code Relationships

EMIS

R 1
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-~ SCR Text File

Open the scr_export.txt file from ODDEX
 Select “Edit” then “Select All” or Press CTRL and A
| * Once data is selected, go to “Edit” and “Copy” or Press CTRL and C

—

| |
[ | 1]
4l | | DEMO SCR_Conflicts_Export_File.txt - Notepad [ | DEMO_SCR_Conflicts_Export_File.tt - Notepad
;3 '
gb ﬁile Edit | Format  View Help ﬁle [m Format Wiew Help
§ S5IC Und Cile7 5T Name conflict Code cConflict Effy Und Cile 7
I EH1- nee ” Last Name WTIC  8/25/2017 nee ” 3;25:}’201?
1 CH3Z Last MName WTIC 8/25/2017 s B/25/2017
;j CN27 Cut Ctrl+X Last Name AFPY  8/25/2017 S Sl 3,{*25,}‘201?
I CXBE C Crl+C Last Name RFIC 8/25,/2017 Co Ctrl+C 8/25/2017
DUS5? oY - Last Name STIC  8/25/2017 4 8/25/2017
EG3E Paste Ctrl+V Last Name RFIC 11/27/2017 Paste Crl+V 11/27 /2017
GQBE Last Name AFPY 9/3/2017 Delet Del 9/3/2017
I 1067 Delete Del Last Name EPCT  12/13/2017 elete ¢l 12/13/2017
j MKS4 Last Name STIC 8/25/2017 _ 8/25/2017
i PG2E Find... Ctrl+F Last Name EPCT 11/27/2017 Find... Ctrl+F 11/27/2017
1/ PG2E ) LasT MName AFIC 11/27,/2017 Find Next £ 11,.-’2;;“201;
VBT Find Mest F3 Last Name AFIC 12/8/2017 M 12/8/2017
| Replace... Ctrl+H Replace... Ctrl+H
Go To... Ctrl+G Go To.. Ctrl+G
‘ Select Al CtrieA |} Select All Ctrl+A
{ Time/Date F5 Time/Date F5

\ Alliance



~ Copy Data Into Excel
|

O E I h H @ > = Bookl —Erce——— —
pen Xce ’ t en FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
place cursor |nt0 &D ;;E”t Calibri -1 <A A == ®- EWapTet General - |;'J D
B Copy ~ R S g , 0 iti s
Ce” A1l Paste mat Painter I U- #. B-A- === &= EMerge&Center - $-% * 5 3 Fi?:ndalg;jnngalv Format o Sb'ilil
Clipboard Font P Alignment P Mumber P Styles
\ Al Calibri -~ |11 R
ABI=0-AN : F G H I J K L M N
1
2 a6 Cut S | “ ” . h
o cony elect "Paste” or right
- N
4 i, "
O Paste Options: . o V4
: L/ click, then “Paste” or CTRL and V
5]
‘j‘ 7 Paste Special...
I’ 8 Insert...
j d Delete...
| 10
11 Clear Contents
12
13 Filter »
‘\: 14 Sort N

EMIS
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’ Prepare the SCR Export Report

* Select Header Row and Wrap Text
* Freeze Top Row

e Justify column width

|  Apply Filters



Review SCR Conflict Data

Data on the report is separated by LEA1 and LEA2 the same as
clicking on the Conflict Code and viewing the Conflict Details

IN

SCR

e Students can have more than one line when they have multiple

errors

R I = TR ) IR N W I L% I Y

M

LEAL Admitted From
LEAL Admitted From
LEAL Admitted From
LEAL Admitted From
LEAL Admitted From
LEAL Admitted From
LEAL Admitted From

M
LEAT
How
Received
Code

*

eI

m

LEAL

LEAL How Received
LEAL How Received
LEAL How Received
LEAL How Received
LEAL How Received
LEAL How Received
LEAL How Received

LEAL
Sent

Reason LEA1 Educating or Resident IRN

OE

LEAL Educating or Resident
LEAIL Educating or Resident
LEAIL Educating or Resident
LEAIL Educating or Resident
LEAL Educating or Resident
LEAL Educating or Resident

LEA2 [

Reportin
ELEAZ
Reporting LEA2 Name LEAZ2 Date Range

40404 Reporting LEAZ Name

50505 Reporting LEAZ Name

30302 Reporting LEA2 Name

60606 Reporting LEA2 Name

40404 Reporting LEAZ Name

50505 Reporting LEAZ Name

LEAZ LEAZ LEAZ
Percent Admissio Admissio

Of Time n Date n Reason

EMIS
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Quick Check

Exporting data from SCR in
ODDEX and copying the data
into Excel provides a quick
way to sort and filter as the
data is reviewed.
Spreadsheets of data along
with district notes added to
the spreadsheet can be easily
saved for future reference.

* Are you regularly submitting updated
SCR data to EMIS?

* How often do you review SCR data in
ODDEX?

* Are you using Excel as an additional
tool to review SCR data?

EMIS
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Calendar and Student Data
Comparison
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Calendar Data and Student Data

e Calendar Collections contain calendar data and no student
data

* Student Collections contain student Building IRNs, State
Equivalent Grade Levels, and Attendance Patterns

* The data does not meet until the FTE Reports are generated

* Using Excel, the data can be compared to ensure that
calendar data and student data align



Data Collector Files

* From the most recent Calendar Collection view the
Submission/Preview Files
* Open the Grade _Schedule Record (DL) file

* From the most recent Student Collection
* Open the Student_Attributes Effective Date Record (FD) file

* Prepare both files for review



~ Sort the DL File

T d o 2 = ule REToTo DT txeer—
| Select the bOX in the h HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
m . ) "’,f,‘ r .¢- M [&] Connections al 'ﬁ' '\Y ::’,E_ :‘_‘:
| Upper left corner o oy Frrt FaOt| By | P (L Son W g Tetto fh Remowe | O
Get External Data Connections
between the 1and the A | From the Data tab
R o V4
2 ¢ __o choose “Sort”, then Sort
1 Building IRN Grade Code Attendance Pattern Code Firstdayo
2 101010 KG FE 8/ o ”
e 8, by Bwldmg IRN
4 101010 PS AP -7 IE— T
5 101010 PS AS T
6 202020 01 S =
; ig;gig gi x:;v : ,' +';lAdd Level ]1 < Delete Level J [ Options... ‘ V| My data has headers
9 202020 02 *x Column ort On Order
10 202020 02 ML | |S°tbY  Building IRN | | values |w| | Smallest to Largest v/
11 202020 02 MW Then by | Grade Code v| values lv|] |Atoz v
==l | Attendance Pattern ¢ v |  Values l»] |Atoz v
7 ” /J
Select “Add Level” and sort by /h; —
ll % .
Grade Code”, repeat and sort e
o MW - [ OK ] ' Cancel
by “Attendance Pattern Code”
EMIS
- T h\uk 14
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IR

Sort Error

H g > = —
FILE HOME IMNSERT POAGE LAY OUT FORMULAS DT A REVIEW
[ e | A ATA A sort error occurs when a
@ (s [n (2 B | [[3Ecre o0
I s # alz | h ' |

Frorm From From From Other Existing Refresh l:l Sort CO umn as numerlc Va ues
Access Web Text Sources « Connections All - a

Get External Data Connections s{ formatted as text and can be
A2 - fx 101010 .

: ignored
A B C D
1 |Building IRM Grade Code Attendance Pattern Code First day of school Last day of school Hours Per Diay Reg
2 101010 | KG FE B8/14a/201= Efaalono B
3 101010 PS ** 2/14/201 L d f | d d |' k IIO KI’
4 101010 PS AP 8/14/201 eave as dertau te dana CliC
g 101010 PS AS 21472017 S 28 20LTE SN
5 20202001 R 8/f14/2017 5/25,/2018 B Ye
T 202020 01 ML Sort Warning L | =) |! g !l
8 2020200 | 0L P
9 202020 02 *= The f::ull::u'!.n.ring scu_rt key may ng¥sort as expected
10 202020 02 ML because it contains some n bers formatted as text:
Grade Code
11 202020 02 MW What would you like tgZdo?
12 202020 03 = | M| @4 anything thaf looks like a number. a5 a number;
13 202020 03 ML nd numbers stored as text separately
14 202020 03 AW ok ¥ | | cancet || Hep |
15 202020 04 * % I
16 OO0 kA nAl EMIS
"'-".m\w 15
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Minimize DL File

B H S

T -

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

®

(2] Connections

T

—

DEMO_2_Grade_Schedube_Record_(DL)xde - Breg——————————————— k4

?

=]

mmy

L L% L L& = o 1257 i i
From From From From Other Existing Refresh Filter v, Tedtto Flash Remove Data Consolidate What-If Group Ungroup Subtotal
Bccess Web  Text  Sources~  Connections  All- Whdvanced  Columns  Fill  Duplicates Validation = Anabysis - - .
Get External Data Connections Sort & Fister Data T Cutline

Al - f\ Building IRN

A 8 c D E F G 3 - - - -
1 laulldmé IRN 'Grade Code Attendance Pattern Code First day of school Last day of school Hours Per Day Record Is Valid M
2 101010 KG FE 8/14/2017 5/24/2018 6 Yes I n I I I I I Z e e I e O n C e
3 101010 PS - 8/14/2017 5/24/2018 5.5 Yes
4 101010 PS AP 8f14/2017 5/24f2018 5 Yes
5 101010 PS As 8/14/2017 5/24/2018 5 Yes ° °
6 202020 01 - 8/14/2017 5/25/2018 6 Yes
i it is prepared and sorted
8 202020 01 mMw 8/14/2017 5/25/2018 6 Yes
9 202020 02 - 8/14/2017 5/25/2018 6 Yes
10 202020 02 ML 8/14/2017 5/25/2018 & Yes
11 202020 02 Mw 8/14/2017 s5/25/2018 6 Yes
12 202020 03 v 8/14/2017 5/25/2018 6 Yes
13 202020 03 ML 8/14/2017 5/25/2018 6 Yes
14 202020 03 Mw 8/14/2017 5/25/2018 6 Yes
15 202020 04 - 8/14/2017 5/25/2018 6 Yes
16 202020 04 ML 8/14/2017 5/25/2018 6 Yes
17 202020 04 Mw 8/14/2017 5/25/2018 6 Yes
18 202020 05 e 8/14/2017 5/25/2018 6 Yes
19 202020 05 ML 8/1a/2017 s5/25/2018 6 Yes
20 202020 05 MW &/14/2017 5/25/2018 6 Yes

202020 06 s 8/14/2017 5/25/2018 6 Yes

202020 06 ML 8/14/2017 s/25/2018 6 Yes

202020 06 Mw 8/14/2017 5/25/2018 6 Yes

202020 KG FE 8/16/2017 5/25/2018 6 Yes

202020 KG ML 8142017 5/25/2018 6 Yes

202020 KG Mw 8/14/2017 5/25/2018 6 Yes

303030 01 - 8/14/2017 5/25/2018 6 Yes

303030 01 ML 8/14/2017 5/25/2018 6 Yes

303030 01 Mw 8/14/2017 5/25/2018 6 Yes

303030 02 - 8f14f2017 5/25/2018 6 Yes

303030 02 ML 8/14/2017 5/25/2018 6 Yes

303030 02 Mw 8/14/2017 5/25/2018 6 Yes

303030 03 v 8/14/2017 5/25/2018 6 Yes

303030 03 ML 8/14/2017 5/25/2018 6 Yes

303030 03 Mw 8/14/2017 5/25/2018 6 Yes

303030 04 - 8/14/2017 5/25/2018 6 Yes

303030 04 ML 8/14/2017 5/25/2018 6 Yes

303030 04 Mw 8/14/2017 5/25/2018 6 Yes

LGrada Schadiula B. A (O o
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FD File - Cut Columns

CE

B e S

DEMO_Student |

Select the columns for “State
Equivalent Grade Level” and

HOME INSERT FORMULAS DATA REVIEW VIEW Y7 ))

2 - Pe—— T ———— Attendance Pattern”, then select

I Calibri *I11 ~|A A =B v/~ =F Wrap Text
Past: AL > v|| &y e EEE Eass E “ ” 1

S ramarane © 100 0 0-as === == Besad “Cut” from the Menu bar or right

Clipboard M Font r‘. Alignment R “w 7]
K1 v f\ State Equivalent Grade Level Cl IC k a n d C Ut
A B C D E F G H I J ‘
State
Effective Equivale Atte D copy
Fiscal Reportin District Building Start Effective Int Grade nce - .
| y Paste Options:

1 |Yea~|gPeric~ IRN |~ /IRN |~ EMISStudentID Numb¢ v Last Nan v |First Nan v |State Student | v Date | v |/EndDa v |Level | |Patt ot g
2 12018 S 40404 101010 EMIS Student ID Number Last Name First Name State Student ID 20170912 00000000 |PS AS :;_a Z‘ &) ?
3 |2018 S 40404 101010 EMIS Student ID Number Last Name First Name State StudentID 20170701 20170906 |PS AP Paste Special... ’
4 12018 S 40404 101010 EMIS Student ID Number Last Name First Name State StudentID 20170701 00000000 |PS - Ecut ¥
5 (2018 S 40404 101010 EMIS Student ID Number Last Name First Name State StudentID 20170801 20170814 |KG e ) N
6 2018 S 40404 101010 EMIS Student ID Number Last Name First Name State StudentID 20170919 00000000 |PS FE Delete N
7 {2018 S 40404 202020 EMIS Student ID Number Last Name First Name State StudentID 20170701 00000000 |05 |** Clear Contents N
8 2018 S 40404 202020 EMIS Student ID Number Last Name First Name State StudentID 20170701 00000000 |02 ** 1 ] Format Cells... 1
9 |2018 S 40404 202020 EMIS Student ID Number Last Name First Name State StudentID 20170701 00000000 |03 3 Column Width... N
10|2018 S 40404 202020 EMIS Student ID Number Last Name First Name State StudentID 20170701 20170702 |KG FE Hide N
1112018 S 40404 202020 EMIS Student ID Number Last Name First Name State StudentID 20170701 20170816 |06 e i 1
1212018 S 40404 202020 EMIS Student ID Number Last Name First Name State StudentID 20170701 20170813 |04 = ___Iu”h'de N EMIS

N
I
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\
|
|
\
|
1
|
\
|

Insert Cut Cells

!
%

Select the “EMIS Student ID
Number” column, then right click

] H ©- @ > = DEMO_S|
‘ HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW and Select ”Insert Cut Ce”s”
alls 2 Cut a v = ==
7t Calibri ln Ca s == e Eitere ererrEraT - S
13 &g copy - OE = =
Paste i I U -~ fy - - === & 3= [ Merge & Center - $ - <0 oo Conditional Formatas Cel
- ¥ Format Painter - — - J e Formatting = Table = Styled
Clipboard M Font P Alignment M Mumber M Styles
El - fx Calibri "
4 B I
A B C D E F I ] K L ¥
d6 Cut Istate i
1
Em Copy Effective IEquivale Attenda]Disad
Fiscal Reportin District Building ‘4 Paste Options: Start Effective Int Grade nce Intage
1 |Yea~ gPeric~ |IRN [T |IRN |~ |EMI ey State Student |~ |Date |~ End DE"':LEVE' - P:a'rter":ent
| 1
2 |2018 s 40404 101010|EMI [ First Name State Student ID 20170912 00000000 JPS AS i
3 |2018 s 40404 101010|EMI r First Name State Student ID 20170701 20170906 |PS AP i+
| 1
4 |2018 s 40404 101010|EMI Insert Cut Cells Name First Name State StudentID 20170701 00000000 [PS *% I+
5 |2018 s 40404 101010|EMI e ast Name First Name State StudentID 20170801 20170814 IKG *% I+
6 |2018 S 40404 101010|EMI EI - ast Name First Name State StudentID 20170919 00000000 |PS FE i1
{ tents i
7 |2018 s 40404 202020|EMI ar -enten ast Name First Name State Student ID 20170701 00000000 |05 *x i+
| 1
8 |2018 s 40404 202020|EMI =] Fermat Cells... ast Name First Name State StudentID 20170701 00000000 i02 *% I+
9 |2018 s 40404 202020|EMI Column Width.. ~ astName First Name State StudentID 20170701 00000000 103 *% I+
102018 s 40404 202020/ EMI Hide ast Name First Name State StudentID 20170701 20170702 'KG FE 1=
| Im § 1
11|2018 s 40404 202020/ EMI Unhid ast Name First Mame State Student ID 20170701 20170816 Jo6 *% i
1 nhidae
12 |2018 s 40404  202020/EMI o eeomomeemenemmny~85 N@me First Name State Student 1D 20170701 20170813 104 *% 1*
EMIS
w/ N
N 18
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Columns Side by Side

5% o &3 - wosemennd COlUMNS are now in the same order as

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

e o w sxe —-= . suswe | the DL file to easily compare the data
i Copy ~ '
s “Fo:':at Painter Iy~ - O - A || — = Merge&Center ’ $ o ‘”08 fB Ff)?:x\\dai:tiic:\ngal' F?rr:lllaetfs Séleell'
Clipboard M Font ™ Alignment f‘. Number [ Styles
El v f\ State Equivalent Grade Level
A B C D E F G H I J K L M
State
Equivale Attenda Effective Disadva

Fiscal Reportin Distriqt Building|nt Grade nce Start Effective ntagem
1 |Yea v gPeric ¥ IRN IRN | v |Level '[PatteE MIS Student ID Numb¢ v | Last Nan v | First Nan v |State Student v Date |~ EndDa~ /ent ~
2 12018 S 101010|PS AS MIS Student ID Number Last Name First Name State StudentID 20170912 00000000 *
3 (2018 S 101010|PS AP MIS Student ID Number Last Name First Name State StudentID 20170701 20170906 *
4 (2018 S 101010(PS [** MIS Student ID Number Last Name First Name State StudentID 20170701 00000000 *
5 (2018 S 101010|KG “‘ MIS Student ID Number Last Name First Name State StudentID 20170801 20170814 *
6 (2018 S 101010|PS iEE MIS Student ID Number Last Name First Name State StudentID 20170919 00000000 1
7 (2018 S 202020(05 b MIS Student ID Number Last Name First Name State StudentID 20170701 00000000 *
8 (2018 S 202020(02 | |gMIS Student ID Number Last Name First Name State Student ID 20170701 00000000 *
9 (2018 S 202020(03 s MIS Student ID Number Last Name First Name State StudentID 20170701 00000000 *
1012018 S 202020(KG |FE |gMIS Student ID Number Last Name First Name State StudentID 20170701 20170702 *
11(2018 S 202020(06 et |gMIS Student ID Number Last Name First Name State StudentID 20170701 20170816 *
1212018 S 202020(04 s |gMIS Student ID Number Last Name First Name State StudentID 20170701 20170813 *




" Sort the FD File

Select the box in the

FILE

upper left corner B

B H S

INSERT

o Ls

\ From Fron-ﬂ From From Other

PAGE LAYOUT

FORMULAS

DATA REVIEW

VIEW

| : Existin.g Re:Fre:h M Sort Filter Y Advanced Text to
Access Web Sources~  Connections  All~- W Advanced  Column
.v' b etWe e n t h e 1 a n d t h e A Get External Data Connections Sort & Filter
A2 fl ="2018"
i ——
> A c D E F G H I
State
Equivale Attenda
Fiscal Reportin District Building nt Grade nce
1 |Yea~ gPeric v |IRN | v IRN |+ Level + Patter v EMIS Student D Numb¢ = Last Nan v First Nan v Staf]
2 |2018 S 40404 101010 PS AS EMIS Student ID Number Last Name First Name Staﬂ
3 |2018 S 40404 101010 PS AP EMIS Student ID Number | Sart
4 |2018 S 40404 101010 PS AS EMIS Student ID Number
i 5 |2018 S 40404 101010 PS = EMIS Student ID Number | 7| Add Level H 7% Delete Level H
| ‘ 6 [2018 s 40404 101010 PS AS EMIS Student ID Number | | "=.1umn
| | 7 |2018 S 40404 101010 PS AP EMIS Student ID Number | | sort ny
} 8 |2018 S 40404 101010 PS AP EMIS Student ID Number Then b -
¥ StateEqulva\entGrmE Values
! 9 |2018 S 40404 101010 PS AP EMIS Student ID Number
“ 102018 S 40404 101010 PS AS EMIS Student ID Number
112018 S 40404 101010 PS AS EMIS Student ID Num,
12|2018 S 40404 101010 PS AS EMIS Student ID, ber
132018 s 40404 101010 PS AS EMIS Studi
1419018 'S 40404 101010 PS AS EMIS, ber ||
101010 PS AP 1D Number ||
101010 PS AP udent ID Number

Select “Add Level” and sort by
| | “Grade Code”, repeat and sort
| | by “Attendance Pattern Code”

101010 PS

MIS Student ID Number
EMIS Student ID Number
EMIS Student ID Number

L b

E_‘ F [2] Connections 8] E"a ®

E=

i

=]
=

From the Data
choose “Sort”,
by “Building IR

tab
then Sort
NII

- = T
ER Copy Level ” - V| My data has headers
So
Building IRN Values

E Values

FEE

Order
Smallest to Largest
AtoZ
AtoZ

=]
[=]
=

a

Cancel

Last Name First Name State Student ID 20170814 OOOOOOOOI’
Last Name First Name State Student ID | 20170701 20171018 *
Last Name First Name State Student ID 20171019 00000000 *

xx =
*% *
05 *

P &

Z2 2 2

EMIS

20

o [N
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. Remove Duplicates in FD File

| | Select all data in the spreadsheet Al g =i E-B

Rermaowve
l " Adw Columns Duplicates

then from the Data Tab, select

“Remove Duplicates” H | In the Remove Duplicates

Prompt, click on “Unselect

| Equivale Attenda
Fiscal Reportin District Building nt Grade nce ))
| 1 Year gPeriod IRN IRM Level Pattern EMIS Student ID Number Last Mame First Mams AI I ) then CheCk the boxes
| | 2 12018 |S 40404 101010 PS - B
a Remowve Duplicates . .
| B 3 |2018 s 40404 101010 PS e — — t t ”B Id I R N”
.q,'-" “ a lpo18 s 40404 101010 PS To delete duplicate values, select one DW n eX O u I I ng )
| = o=
‘ 5 |2018 s 40404 101010 PS #= select anl | | 3= unselect an | 7 myad ., ate uiva en rade
j 6 |20128 s 40404 101010 PS St t Eq | t G d
7 2018 S 40404 101010 PS col
oIUmmns
8 |2018 s 40404 101010 PS E—— L | Y, d 7, d
. [EEa e evel” and “Attendance
10|2018 s 40404 101010 PS il
12 o s to101[ sosoiolrs ;e Pattern” and click “OK”
122018 S 40404 101010 PS | state Equivalent Grade Level
132018 S 40404 101010 PS +| Attendance Pattern )
14 |2018 |s 40404 101010 PS5 [ = ] | — | 20171
‘ 152018 S 40404 101010 PS 2017
\ 162018 S 40404 101010 PS 2010
\ EMIS

&\ NS 21
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Duplicates Removed

Fiscal Reportin District Building StudentID

State Start

H ©- @3 X = e
FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
® | Message will indicate how many duplicates |58 8§ =
Fram F Remove Data Consolidat
w1 were found and how many unique vohates Voidtion >
values remain, click “OK”
A B C D E \ F G H I J K L
State
EMIS Effective Equivale Attenda

Effective nt Grade nce

1 Yea~ | gPeric~|IRN |~/IRN |~ Number ~|Last Name - | First Name v |Student IC ~ |Date |~ |End Da v |Level |~ Patter ~
2 |2018 'S 40404 101010 EMIS Stude Last Name First Name ‘State Studen 20170912 00000000 PS AS

3 |2018 s 40404 101010 EMIS StudeLast Name e -

4 12018 S 40404 101010 EMIS Stude Last Name

5 |2018 S 40404 101010 EMIS Stude Last Name A

6 (2018 S 40404 101010 EMIS Stude Last Name '0:' 10454 duplicate values found and removed; 79 unique values remain.
712018 S 40404 202020 EMIS Stude Last Name

8 |2018 S 40404 202020 EMIS Stude Last Name

9 (2018 S 40404 202020 EMIS Stude Last Name Was this information helpful?

10(2018 S 40404 202020 EMIS Stude Last Name —

EMIS

N
. .
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Compare the Data

* The two spreadsheets have unduplicated instances of Building IRN,
Grade Level and Attendance Pattern

 Compare the two spreadsheets to verify that all combinations in the
FD file appear in the DL file

* When Grade Level contains asterisks **, the asterisks should be
treated as wildcards that can be matched against any grade level

* There could be DL records that are not represented in the FD file

EMIS
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Arra nge All With both spreadsheets open,

. o I |II
- from the View Tab, select “Arrange A
| H © ¢ @ X -
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW /
= ~ = . B —1 =1 [ == [JSplit [
| IE] Ruler v| Formula Bar Q L > !' Ca — Ems
— o = O L1 5% =i
Normal Page Break Page Custom [ Gridlines v Headings Zoom 100% Zoomvto New Arrange Freeze s
Preview Layout Views Selection Window All Panes~ ny
111 Workbook Views Show Zoom Wind
|
G10 vl (f\ EMIS Student ID Number
o ko i = = the Arrange dows
State I o H I”
Enutvale [Attend prompt, select “Vertica
Fiscal Reportin District Building nt Grade nce >

1 Yea~ i gPeric v IRN |~ |IRN v |Level | v |Patter ¥ | EMIS Student ID Numbe¢ v | Last Nan v | First Nan ~
2 2018 S 40404 101010 KG g EMIS Stude R 2 — udent
3 2018 S 40404 101010 PS == EMIS Stude - ate Student
4 2018 S 40404 101010 PS AP EMIS Stude State Student
5 2018 S 40404 101010 PS AS EMIS Stude ime State Student
6 2018 S 40404 101010 PS FE EMIS Stude me State Student
7 2018 S 40404 202020 01 e EMIS Stude i i me State Student
8 2018 S 40404 202020 02 e EMIS Stude @ Cascade me State Student
9 2018 S 40404 202020 02 ML EMIS Studen) P} Windows of active workbook ame State Student
10'2018 S 40404 202020 03 - EMIS Studen ime State Student
11 2018 S 40404 202020 04 == eMisstuded)| | ok || cancet | ||Bme state student
12 2018 S 40404 202020 05 i EMIS Stude ———JM&ame State Student EMIS

s
P 2
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Apply Filters and Compare Data

Filter on one Building IRN at a time

B H ©- @7 2 s DEMO_ Student_Attributes_Effective_Date_Record_(FD).,
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Hrosch, T... = FILE HOME INSE
= v 3 1% i - — - T F 2 |4 Q : l
Tables Niustrations Add- Recﬂjﬂrﬁ;nded W~ *' Vi~ Pi\.’ﬂt:(;h‘art Sparklines Filters Links Text Symbqr xternal Refr::h z|
- ins Charts @~ L2~ - - - - - 3 Data - All» Y
Charts ~ Connections
Al - f\ Fiscal Year Al
4 A B C D H I 4 A
/ Attend
Equivale Attenda ance
Fiscal [Reportin District Building nt Grade nce uildin Grade Pattern
1 [Yea ¥ lgPeric ~ |IRN [~ [JRN |-T Level | - |Patter ] EMIS Student ID Numb¢ ~ | Last Nan - |First Nan ~ IRN-T|Cod| ~ | Code| ~
2 12018 S 40404 | 101010 KG i EMIS Student ID Number Last Name First Name 2 101010 KG FE
3 /2018 S 40404 | 101010 PS b EMIS Student ID Number Last Name First Name 3 |j101010 PS b
4 2018 S 40404 | 101010 PS AP EMIS Student ID Number Last Name First Name 4 [J101010 PS AP
5 /2018 S 40404 | 101010 PS AS EMIS Student ID Number Last Name First Name 101010 PS AS
6 2018 S 40404 | 101010 PS FE EMIS Student ID Number Last Name First Name 130
80 131
81

Compare the students on the left to the
DL file on the right. Are all combinations
appearing on both files?

AGE LAYOUT FORMULAS DATA REVIEW VIEW Hrosch, T... ~
Y Y Clear ¥ [E Flash il B+o 8

Firg|
of s
8/1
8/1|
8/1
8/1

Remember that ** for

an Attendance Pattern

is a specific Attendance
Pattern while ** for Grade
Level is a wildcard for any
Grade Level

EMIS
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Quick Check

Since Calendar Data and
Student Data don’t meet until
FTE Reports are generated,
data integrity issues could
exist without error. Cross
check the data to identify
issues between calendars and
students.

* Are you comparing data from the most
recent EMIS submissions?

* Do all student Building IRN, Grade
Level, and Attendance Pattern
combinations appear in the DL file?

* Should any unused calendars be set to
not report to EMIS?

EMIS
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Staff Data Formatting to
Share with District Staff

Alliance



Sharing Staff Data

Staff EMIS data can come from a separate source system that
is often managed by someone other than the EMIS
Coordinator

| e Sharing staff EMIS data can be a helpful when correcting and
‘P verifying the data
| * Consider sharing

* Level 1 Validations

e Submission Files

* Level 2 Reports

 Staff and Course sections of the EMIS Manual

EMIS
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\ EMIS Manual Sections

3.9 POSITION CODES

7 Sections of the EMIS Manual
NUMERICAL LISTING OF POSITION CODES
Official/Administrative Positions (1xx) could be hElpr' to staff as

Table 1. Official/Administrative Positions they ve rlfy d ata in an E M lS
‘éﬂj{i‘°“ uescripdon submission file such as the Staff
Administrative Assistant Assignment I Em o | oyme nt File (C K)

101 | An assignment to perform activities assisting an executi

ties 1 the school district.

Assistant, Deputy/Associate Superintendent Assignment

103 An.assigmnent to a sta_ff member (e.g.. an assistant.. deputy or associfite spperi.utendent or the
assistant) to perform high-level. system-wide executive management functions in a school dis-
trict.

Assistant Principal Assignment

104 An assignment to a staff member (e.g., an assistant, deputy. or associate principal) to perform

: high-level executive management functions in an individual school, group of schools. or unit(s)
\ of a school district

EMIS
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Prepare the Data for Review

* Some EMIS data files and reports can be quite large

* Preparing the data before distribution could bring back better results
from staff

. * Consider doing some of the following:

| e Basic report preparations such as wrapping the text in the header row
Deleting unneeded columns

Sorting or Filtering

Separating data by building

Highlighting cells

Printing or emailing the data

EMIS

Alliance



Staff and Course Level 1 Validations

./ Initial Staff and Course Collection (FY18)

o
Select “Level 1
FY18-L-Stf Crs Init: Collection required for all EMIS reporting entities. The beginning of vear staff collection includes staff employed

Validations”
Submissions: October 03, 2017 - January 31, 2018
Version: 3 From ODE: Level 2 Reports
Status: The collection was submitted December 11, 2017 at 04:17:19 PM by
Submission Status:

Processing Completed (December 11, 2017 at 04:17:00 PM)
Submission Number: 4 (attempt 1)

Actions: Start Collection
Add Mew Scheduled Collection
Set Default Collection properties

Prepare Outputs: Level 1 Validations
View submission 3 Data

EMIS
\

o/ N 31
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Level 1 Validations

Initial Staff and Course Collection (FY18)
Submission Number 4 (attempt 1}, LEA: Franklin-Monroe Local

Output Type

The walidation exception report can be viewed
as an HTML pop-up or downloaded as a CSV

Validation exceptions are listed by record type and exception severity.
To generate the exception report for one record type and/or exceptio ™

row and column.

Last Prepared: December 11, 2017 (17 days ago) at 04:15:17 PM

Record Type

Career-Technical Education Correlated Class Record {CV)
Contract Only Staff Record {CC)

Contractor Staff Employment Record (C1)

Course Master Record {CN)

Mapped Classroom Code Record (CM)

Staff Course Record [CU)

Staff Demographic Record (CI)

Staff Employment Record (CK)

Staff Missing Overnde Record (CP)

Staff Summer Employment Separation Record (CL)
Student Course Record (GHN)

Total Counts:

Generate Full Validation Report

Click on the link below to download the zip fi

AllRTs046649-2018L1 5TRv2-subq-1AlSevs2017-12-28 08-12-31.csv

Fatal Critical Warning Info

I [l T
|._\_JDDD|LUI-L‘~|DDDDDD

P
<

file(s). CSV file(s) will download as a
single .zip file.

TS T

“"in the corresponding
LJHTML '® Csy

CSV Output Optio

ITG::EI | Depnd Valid Y¥ou can create a separate
v1Er

<\ file for each
Invalid Recs Record Type by checlang the
[§] 0
0 0 [ record Type Qe

Select Output Type “CSV”
and uncheck the CSV
Output Option for “Record
Type”

[ N e R e I e Y e Y e Y e R e [ e Y e Y e [ e |
ololalolalelalalalelala
[oocolpkEeoooa
[%3] [N | R [ ]

Select “Generate Full Validation Report”
and then open the report

EMIS
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Level 1 Validations ,cont’d

[T TR+ IR R - "I T PV R TS

[l S R S R S SR
(ST R IV S

consider sorting by Employee Name or adding
additional explanations to aid in identifying the issue

A B C D E F G H I ]
Local
Error Error Local Classroom  Position Contract
Mumber |Level NMessage Description Employee ID Employee Name State 5taff ID Code Code Code
CU.D007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher e =
CU.0007 Fatal Element value cannot be blank  (CU100) Missing value for Highly Qualified Teacher Er U E I k k
CU.0007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En SI ng Xce Ca n m a e WO r I ng
CU.D007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En
CU.0007 Fatal Element value cannot be blank  (CU100) Missing value for Highly Qualified Teacher En th ro u g h Level 1 Va | Id at I O n S
CU.0007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En
CU.D007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En 1 1 d b
CU.0007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En ea S I e r SI n Ce reCO r S Ca n e
CU.D007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En
CU.0007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher En q U IC kly SO rtEd O r fl Ite red
CU.0007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher Elpeye—re—rprey=—rrorr———ror——wor
3 |CU.0007 Fatal Element value cannot be blank (CU100) Missing value for Highly Qualified Teacher Employee ID Employee Mame State Staffl[] AAHS-445UR-01
cy . . . . . 1D AAHS-240UR-01
« Before sending this to district staff for review, 0| s 0701

EMIS
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" Submission Files

Staff and Course Collection Submission Files/Review Data

-/ Initial Staff and Course Collection (FY18)
FY¥18-L-Stf Crs Init: Collection required for all EMIS reporting entities. The beginning of year staff collection include

\
! Submissions: October 03, 2017 - January 31, 2018

‘ Version: 3
Status: The collection was submitted December 12, 2017 at 01:55:28 PM by Walters.

\ Submission Status: Processing Completed (December 12, 2017 at 01:55:03 PM)

Submission Number: 5 (attempt 1)

Actions: Start Collection
Add Mew Scheduled Collection
Set Default Collection properties

Select “View Submission Data”

Prepare Outputs: 7
View submission 4 Dat;

Initial Staff and Course Collection (FY18)
Submission Number S (attempt 1}, LEA: Ansonia Local

|
Use the Generate Review Data link to review the data previously submitted.

|
Last Prepared: December 12, 2017 (15 days ago) at 01:20:38 PM

] Detail
] Missing Data

1
i
/,,
Zip File: [ | pownload file as a compressed .zip (for faster downloads
File Format: () HTML
o Csv

®) Data only
D3 #hd Fatal exceptions

Include in CSV files:

Data and All exceptions

Generate Review L-ata

Select “Generate Review Data”

EMIS

"
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" Review Files cont’d

Submission 5 | Suba
File vValid Invalid Total | Valid
- ni ion ﬁ I r V). . .

o ons st st | Open the Staff Demographic Record (CI) file

Contractor Staff Employment Record (CJ).csv 0 0 0 | 0

Course Master Record (CN).csv 373 0 373 | 365

Excluded Records.csv |

Mapped Classroom Code Record (CM).csv 0 0 0 | 0

Staff Course Record (CU).csv 367 5 373 | 363

Staff Demographic Record (CI).csv 109 0 109 | 106

Staff Employment Record (CK).csv 158 0 158 | 153

Staff Missing Override Record (CP).csv 0 0 0 | 0
| Staff Missing Report.csv 0 |

Staff Summer Employment Separation Record (CL).csv 0 0 0 | 0

Student Course Record (GN).csv 5200 0 5200 | 5148

Total counts: 6207 5 6218

EMIS
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Sharing Data for Review

* Prepare the file for review

* Add grid lines

* Print titles at top of each page
* Add a header

* Select page setup options

* View print preview

iiiii



 Prepare the Staff Demographic File (Cl)

- Demographic file contains one line per staff member
* Prepare your spreadsheet to be user friendly

A B C D E F G H I ] K L M N o] p Q R s T
Early Authoriz
Childhood ed Total Principal
Racial/Et Education Teaching Experience Experienc
Fiscal Reportin District EmplMyee Prefix Middle Suffix State Staff Dateof hnic Education Semester Qualificati Experien Yearsin eYearsin Record s

1 |Year gPeriod IRN ID Name First Name Name Last Name Name ID Birth Group  Gender Level Hours an ceYears Education Education Valid
2 (2018 L 40404 WR2009109 JAMES P ADAMS WR2009109 19630601 W M 3 193 * 25 30 5 Yes
32018 L 40404 MH2595515 MORGAN M AUBURN MH2 . 0 Yes
4 12018 L 40404 ZD1202007 JERALD D. BARGEN ZD1] H e a d e r d ata |S W ra p p e d to p rOW 0 Yes
5 2018 L 40404 MH2529121 LISA R. BECHEL MH2 ’ 0 Yes
6 2018 L 40404 7D1202227 STUART D BEIST ZD1] . . . 0 Yes
;‘ 7 2018 L 40404 IN2025999 JoDI F BENNER IN2( |S frOZE n, a | | d ata |S Vl ewa b | e 0 Yes
;‘ & 2018 L 40404 7D1202272 DEBEORAH A. BENSMORE D1 0 Yes
\ 9 2018 L 40404 MH1227755 JESSICA BEMNNY MH1227755 19860927 W F 2 173 * 3 3 0 Yes
§ 10 (2018 L 40404 7D1202252 JIMES L BOLEN ZD1202252 19500910 W M 0 0* 0 0 0 Yes
,‘ 11 (2018 L 40404 MH2125722 CAREN A BRODRECK MH2125722 19710518 W F 3 169 * 15 15 0 Yes
12 12018 L 40404 ZD1202270 REGINA M BROWN ZD1202270 19701017 W F 0 0=* 0 0 0 Yes
13 12018 L 40404 MH1250971 AMY L FISHER MH1250971 19700902 W F 2 136 * 14 14 0 Yes
14 (2018 L 40404 MH2597599 ASHLEE M FURMAN MH2597599 19840718 W F 3 161 * 12 12 1 Yes
“\_ 152018 L 40404 ZD1202252 ROBIN E FRALEY ZD1202252 15470814 W M 0 0* 0 0 0 Yes
"\‘ 16 12018 L 40404 ZD1202275 SANDRA S GOLF ZD1202275 19570116 W F 0 0=* 0 0 0 Yes
‘ 17 (2018 L 40404 IN2022250 TINA J GREEN IN2022290 19640728 W F 3 209 * 10 22 0 Yes

EMIS
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A B C D E F G H I J K L M N 0 P Q R ) T U |~
Early Authoriz
| Childhood ed Total Principal
‘l Racial/Et Education Teaching Experience Experienc
' Fiscal Reportin Dis IMyee  Prefix Middle Suffix State Staff Dateof hnic Education Semester Qualificati Experien Yearsin  eYearsin Recordls
1 |Year gPeriod IRN D First Name Name Last Name Name ID Birth Group  Gender Level Hours  on ceYears Education Education Valid
2 /2018 L 40404 WR2009109 JA WR2009109 1963
3 [2018 L 40404 MH2595515 MORGAN M MH2595515 1981 S | C I I A d h h |d C
4 (2018 L 40404 ZD1202007 JERALD D. BARGEN ZD1202007 1957 e e Ct e 1 a n t e n O RT L
512018 L 40404 MH2529121 LISA R. BECHEL 982 . . h
ol L | awosmwumm | stuamr o, sest oun o aNd Shift keys down and then Right
7 /2018 L 40404 IN2025999 JODI F BENNER IN2025999 1973 . .
8 (2018 L 40404 7D1202272 DEBORAH A. BENSMORE ZD1202272 1959 A r rOW a n d t h e D OW n A r ro W. T h | S WI I |
912018 L 40404 MH1227755 JESSICA BENNY MH1227755 1984
1012018 L 40404 7D1202252 JIMES L BOLEN ZD1202252 1950 I h d I In,]
1112018 L 40404 MH2125722 CAREN A BRODRECK MH2125722 1971 Se eCt t e rOWS a n CO u n S O n yo u r
1212018 L 40404 ZD1202270 REGINA M BROWN ZD1202270 1970 .
1312018 L 40404 MH1250971 AMY L FISHER MH1250971 1970 SpreadShEEt that contailn data
1412018 L 40404 MH2597599 ASHLEE M. FURMAN MH2597599 1984
15]2018 L 40404 ZD1202252 ROBIN E FRALEY ZD1202252 19470814 W M 0 0* 0 0 0 Yes
16]2018 L 40404 ZD1202275 SANDRA S GOLF ZD1202275 19570116 W F 0 0* 0 0 0 Yes
17]2018 L 40404 IN20222590 TINA J GREEN IN20222950 19640728 W F S 209 * 10 22 0 Yes
1812018 L 40404 MH1259722 ERIC (0) GRILLER MH1259722 19880906 W M 2 177 * 5 5 0 Yes
EMIS
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- Add Grid Lines

‘ [ H ©- ['L'J_‘| Z v DEMO_5_5taff_Demographic_Record_{CI).xlsx - 37—
) g
‘}_ " FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEWY WIEW
. ulls rK\CLIt - F - = — = - £ =
- Calibri -1 A A == #- = Wrap Text General - " 4 | ___J -
ER) Copy = . El s & H 5B
Paste ! T u- i= 5= [Fles oem ['s nr « €0 00 Conditional Formatas  Cell Inzert Del
- ¥ Format Painter - = = H 4
cipborra r| Borders . From the Home Tab select the | «
f i+ Bottom Border
| e 3k id lines | d then sel
J¥ 15 TopBorder grid lines i1con and then select
i Left Border
= o I | d V4
A E c D Right Border H_ A Bor ers P
Mo Border carly
; Childhod
2l Racial/Et Educatio
Fiscal Reportin District EmplMyee Outside Borders Suffix State Staff Dateof hnic Education Semester Qualificg
1 |Y¥ear gPeriod IRN ID Thick Box Border ime Mame ID Birth Group  Gender Level Hours on
2 |2018 L 40404 WR2009105 il Bottom Double Border 5 WR2009109 19630601 W M 3 193 *
3 |2018 L 40404 MH2595515 . ] N MH2595515 19810530 W F 2 179 *
#+i  Thick Bottorn Border
4 |2018 L 40404 7D1202007 — M ZD1202007 19570804 W )| 0 o*
5 (2018 L 40404 MH2529121 == Top and Bottom Border L MH2529121 19820630 W F 3 172 *
6 |2018 L 40404|ZD1202227 - Top and Thick Bottom Border ZD1202227 19840803 W M 2 141 *
EMIS
\ ""'I‘r"'&\wr 39
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Print Titles at Top of Each Page

i > F the P L t tab select th
HOME INSERT PAGE LAYOUT @=L LAS DATA REM ro m e a ge ayo u a Se ec e
L] L ] L]
- Print Titles icon
Themes Page Setup Scale to Fit Sheet Options Arrange
Al - ’ﬁ Fiscal Year
. From the Page Setup prompt pIace
g c o age Setup
————————————————————— - L] ll
Page Margins Header/Footer Sheet th R t p t t
cursor in the “Rows to repeat a
Reportin |District |EmplMyee wla T ” h I 1 Th 1 I I |
gperiod IRN__|iD | (&to repeat at top: §1:31 Op ) t e n Se eCt rOW . IS WI
L 40404 WR2009109 Colufr et "
3 |2018 |L AQA04 | MIH2Z595515 Print | t t h R t R p t t
4 2018 |L 40404|7D1202007 Gridlines Comments: | (Nonel p O p u a e e OWS O e e a a
5 |2018 |L A0A04 | MH2529121 EBlack and white ) - )
. Cell errors as: | displaysg
6 2018 |L 40404 |ZD1202227 Draft guality TO p .
7 |2008 (L 40404 [IN2025999 Row and column headings
8 (2018 (L 40404 | ZD1202272 Page arder 4] o™
9 (2018 (L A0404 | MH1227755 @ Down, then aver EE IE E-—EE 2 173|*
10 (2018 (L AQ404 [ ZD1202252 Cwver, then down | ==z €J-: == ] o*
11 (2018 (L A0404 |[MH2125722 ZERE| =9 3 169|*
12 12018 |L A0404 [ZD1202270 0 o*
32018 |L 40404 (MH125097Y 2 136|*
14 (2018 (L 40404 |MH2597599 Print... | | Print Preview | | Options... | 3 161|*
15 (2018 (L 40404 [ZD1202252 i) ol*
16 (2018 (L 40404 |ZD1202275 [ oK ] | Cancel | 0 of*
17 12078 (1 AQA0A | IN 2022290 3 209]* EM'S

N 40
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-~ Add Header

i E (:C;ME IN[%ZIRTZ TJAGE LAYOUT FORMULAS DATA REVIEW \-'I;E"MO_S_Staﬁ:_DEmDgraphic_Remrd_(Cnlmx-EXCET_ Se|ECt the Page LayOUt tab
R T Dee a B e | hottom right corner icon,
select the Header/Footer tab

Fm"utsv & [[Height: |2 pages - | View
L | Themes . Margins Orientation Size  Print  Ereaks Background Print *"D J P23
\ - D Effects - - - *  Areav 0~ Ti

Print Print

Themes Page Setup
D& Page Setup -__/r 22
—
Header / o ”
[ Page | Margins | Header/Foter 4eafEEL an en ustom mneader
A Header | /
To fo ext: select the text, then choose the Format Text button.
p insert a page number, date, time, file path, filename, or tab name: position the
Header: q insertion point in the edit box, then choose the appropriate button,
Fiscal {none) To insert picture: press the Insert Picture button. To format your picture, place the
N cursor in the edit box and press the Format Picture button,
! Year In the Header prompt, enter
Custom Header... Custom Footer, ’

2 xs )

3 2018 Footer: . . . Y7 17

|| | g section = information and click “OK

5 |2018 Add a title, date, contact -
| & (2018 information,etc.|
| 7 |2018 |
; 8 |2018 |:| Different odd and even pages i i a
\ 9 2018 [ Different first page |
y 10 2018 [¥] 5cale with document oK ] [ Cancel |

11 2018 Align with page margins L -

12 |2018 Brint.. | | Print Preview | | Options... | | 270 |19701017 |W F 0 o= 0

13 |2018 0971 (19700902 |W F 2 136|* 14

14 2018 [ oK ] [ Cancel ] 7599 19840718 |W F 3 161[* 12

15 |2018 252 (15470814 W M 0 0|* 0

EMIS
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Page Setup

Select the Page Layout tab

H o- o 3 - . .
FILE I]HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW  VIEW bottom r|ght CO rner‘ |Con
Calars - ¥ T [ fos Width: |1 pa - | Gridlin
Fontsv @ rli—hl ID IE%! b|_| E:é" Ea Heighty s pages = | [+] View | View -
Themes Margins Orientation Size  Print  Breaks Background Print ) ) Ering
- El Effects ~ - - - Area~ - Tit Print Print Eorwar
Themes Page Setup @ Scale to Fit = Shee|
e sm=) | In the Page Setup Prompt, select
Page | Margins I Header/Footer I sheet o . ))
| Landscape and “Fit To” 1 page(s)
) Portrait @ Landscape < ) . .
fi de by 1tall. Ify port
— || wide all. If your report is
“ 1 |Year ) Adjust to: | BE =% normal size B .
j 2 |2018 @ Fit to: 1 = | page(s) wide by |1 2| tall (109 |1 Iarge, Increase the number Of
| 3 (2018 5515 |1
! 4 “ ) .
J ; igi: Paper size: Letter (5.5" x 117} |E| .szl i pages taII to prlnt.
& 2018 Print guality: | 600 dpi =] [B27 [
'; Iigi: First page number: | Auto | A " ?3DGDE|W |F |
- o . . V24
e ] Select “Print Preview
[k 11 2018 E722 1
o 12 |2018 Brint.. | | Print Preview | | Options.. | | ||[270 1;;;:;;2 ::f |r=
1 A 13 2018 Po71 [15700902 |w F
" 14 |7018 [ oK ] [ Cancel ] 7599 |19840718 |W F
| \ 15 |2018 252 19470814 [w M
EMIS
\
\
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|
|

- Print Preview

|
|
i
|

Account

Options

In)
[=]

B,
m
4]
[
4

Printer

. ; Upstairs Copier
.3_!9 Offline

Printer Properties

Settings
Print Active Sheets
Only print the active sheets
- o =
Print One Sided

Only print on one side of th...

il A&

Collated
1,23 123 123

Letter (85" x11")
85" x11"

MNarmal Margins

Left 0.7" Right 0.7"

Fit Sheet on One Page

Shrink the printout so that it...

E=
D Landscape Orientation -

Page Setup

Print Preview is a great way to adjust the
data on the page prior to printing

A a i, S, cor et it e,

Consider using narrow
margins or changing the

raw tzzoleg |Taest "

e rmmd | m=aws S

e - 2w ;

I L el w L] L]

== . = p w
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= = = ;
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e S aana 1 L]
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Quick Check * What columns of data on your report
Formatting your reports prior could be hidden or deleted to make the

to printing can result in easier report easier to review?

to review documents that * Have you included instructions to hel
district staff will appreciate. Y P

Adding a title, date and understand the data in the report?

contact information will allow * Are you able to set up your report into

easy tracking of when and to : 5
whom the data was sent. a printable format:

EMIS
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FTE Detail Report Subtotaling
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- FTE Detail Report Subtotaling

' Subtotal the FTE Detail Report
|  Sort by SSID, then by Enrollment Start Date

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA uuibisieiis
B [ B | [ S o[ From the Data Tab choose Sort
®E (& |l (& i L& 2l |37 €= Bl
From From From From Other Existing Refresh Z| Seort Filter Text to TEmTovE UStd ——COTSUNUAte —VviTar
Access Web Text Sources~ Connections  All~ Yo Advanced  Columns Duplicates Validation ~ Analys
Get External Data Connections Sort & Filter Data Tools
A2 - Jx || 40404

. s ¢ o ¢ ¢« w . , SortbySSID, then select “Add Level”,
then sort by “ENRL START DATE”, then

RPT DEST SEVERITY

1 IRN Bldg IRN CODE SSID EmisID Last Name  First Name o ))
J 2| 40404 101010/F AF5330185 EMISID LastName First Namg S e | e Ct O K
| 3| 40404 101010 F AF9794373
4 | 40404 101010 AF9794373 27Tz
5| 40404 101010 C AF9794373 12/12/2i
; 6| 40404 1010101 AG3444498 07/01/2
J 7| 40404 1010101 157050894 | || Column 07/01/2
8 | 40404 1010101 17050894 ||| |Sortby ssip (=] |Atoz ~| ||PD 09/04/2
9 40404 101010 | 157998181 Then by | ENRL START DATE Values AM 10/17/2!
10| 40404 1010101 KJ3857778 D 07/01/2
11| 40404 1010101 KJ9471903 07/01/2
“ 12| 40404 101010 I KJ9471903 09/04/2
\ 13| 40404 1010101 KL6339882 07/03/2!
\ 14| 40404 1010101 KL6339882 12/13/2
15| 40404 1010101 KL8833970 07/01/2
16| 40404 1010101 KL8833970 09/04/2
17| 40404 1010101 KL9685822 M 08/21/2 EMIS
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- Sort Warning

|
|
i
|

v
%

!

[ Name
[ Name
I Name
[ Name
I Name
[ Name
I Name
I Name
[ Name

t Name

[ Name |
tName

First Name Middle Name

Sort Warning

This Sort Warning is generated because the ENRL START DATE column
contains some numbers that are formatted as text

111111 FTED-001 FT!

If a Sort Warning is generated,

ENRL START DATE
What would you like to do?

The following sort key may not sort as expected
because it contains some numbers formatted as text:

leave as defaulted and select “OK”

0000/

@) iSort anything that looks like a number, as a g

) Sort numbers and numbers

OK <« Cancel

s text separately

FirstName  Middle Name

Help

40404 FTED-001 FT0000

EMIS
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Apply Subtotals

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
m M S (2] Connections 4| [ZTA| v = W= 4 Hes €rt
e e < s, v |AlZ S (=F BH ® B ? H BES
From From From From Other Existing Refresh zl Sort Filter Textto Flash Data  Consolidate What-If Subtotal
Access Web Text Sources~ Connections All~ Y’ Advanced  Colymns  Fill Duplicates Validatio Analysis ~ v
Get External Data Connections Sort & Filter Data Tools Outline i
S e F the Data Tab select Subtotal
A B C D E F G H 1 J K .
I
=2 _'In the Subtotal Prompt select
RPT DEST SEVERITY RECTYPE RESUL] n e u O a ro S e e C
1 |IRN |Bldg IRN CODE  SSID EmisID LastName  Fje=ta —Aiddlasia LCA-LDAL CODE .
2| 40404 101010 F AF5330185 EMISID LastName | Subtotal R EH ™) ‘S 1 ”At ea Ch Ch a nge | n N SSI D
3| 40404 101010 F AF9794373 EMISID LastName R . .
4| 40404 1010101 AF9794373 EMISID LastName prs ” . )
5 40404 101010 C AF9794373 EMISID Last Name S~ 2 U f t ° S r T l
Use function:
6| 40404 1010101 AG3444498 EMISID LastName Sum * Se u n C IO n * u
7 40404 101010 1 1S7050894 EMISID Last Name Add subtotal to: " Y,
8| 40404 1010101 157050834 EMISID Last Name e LA Ot 3 Ad d bt t | t . O R I G FT E d
9 40404 101010 1 1S7998181 EMISID Last Name ! ENRL END DATE ° S u O a O * a n
10| 40404 1010101 KI3857778 EMISID LastName T
1| 40404 1010101 KIS471903 EMISID LastName 4| ADJSTD SPECED CAT FIE A DJ STD FTE an d A DJ STD S P EC E D
12| 40404 10101011 K19471303 EMISID LastName N
13 40404 101010 | KL6339882 EMISID Last Name V| Replace current subtotals
14 40404 101010 | KL6339882 EMISID Last Name Page break between groups CAT FT E
15 40404 1010101 KL8833970 EMISID Last Name V| Summary below data
16 | MIS | 1 ) )
40404 101010 KL8833970 EMISID Last Name pom—— = [ — “w 7]
17| a0s0s 1010101 KL9685822 EMISID LastName | - —— _ 4 S ele Ct O K
18 40404 1010101 KM8256755 EMISID LastName ST ~TVITOOTE e BURU FTED? .

EMIS
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FTE Detail Report Subtotaled

—“ HOME IMSERT PAGE LAYOUT FORMULAS. DATA REVIEW VIEW
Ty B [ h =) Giane | s, [— - = ] IE ErE * , .
B2 ln 4 (g oo ol Y g B BE =X B B3 B G g It
From From From From Other Exxsting Refresh | Sort Filter Tetto Flash  Remove Data Consolidate  What-§ Group Ungroup Subtotal — e Desal
Access Web  Tet  Sources~  Conneclions All = L Lar o T*-1"5'd""’n‘:!d Columns  Fill |'.Iu|:|||-; abes Vahdation = .ﬁnal:,-':.l*_. = = =
b Get External Dat ] faxt o cis fiats Yo L &
& : . ) . o o o
= This student’s Original FTE, Adjusted FTE, and Special
s | Education FTE, have been subtotaled and R
appear chronological order o
RPT DEST RPECED
1 IRN Bldg IRN CODE SSID EmisID LastName  FirstMame  Middie Name LEA IRN C CODE DESCR CODE DATE DATE ORIGFTE FTE CATFTE LEGALDI]
| 2 -ﬂ-ﬂdﬂ-ﬂ. 101010 F AF5330185 EMISID Last Name First Mame Middle Name 40404 FTED-D01 FTE Detail NFRG 08/01/2017 12/31/2500 1 0 222332
- 3 AFS5330185 Total 1 [1] 0
[ 4 40404 101010 F AF9794373 EMISID LastMame  FirstName Middle Name 40404 FTED-001 FTO0D0 FTE Detail 070172017 12/11/2017 0.376623 (1 40404
5 40404 102010 | AF9794373 EMISID LastName  FirstName  Middle Name 111111 FTED-001 FTOO00 FTE Detail PSET 017 12/31/2500) 0.612676 0612676 0.612676 |444444
B 40404 101010 C AFIT34373 EMISID  Last Name First Mame Middle Name 40404 FTED-001 FTOODD FTE Detail PSRD 1:-.';"12,-"201 1/25 0.623377 0.387324 0.387324 | 404304
il 7 AF9794373 Total 1.612676 1 1
. 3 40404 102010 1 AG3444498 EMISID LastMame  FirstMame  Middle Name 111111 FTED-001 FTOO00 FTE Detail SPCO  07/01/2017 12/31/2500 1 1 1 4aga44
- g AG 3444998 Total 1 1 1
10 40404 102010 1 ISTOS508%2 EMISID  Last Name First Mame Middle Name 40404 FTED-001 FTOO00 FTEDetail OPDD 07/01/2017 09/03/2017 0.020547 0.020547 333333
11| 40404 101010 | IS7050694 EMISID LastMame  FirstName Middle Name 40404 FTED-001 FTOOD0 FTE Detail OPDD 09/04/2017 12/31/2500 0.979453 0979453 333333
- 12 157050894 Total 1 1 0
13 40404 102020 1 157998181 EMISID Last Name First Mame Middle Name 111111 FTED-001 FTOODO FTE Detail COMM 10/17/2017 12/31/2500 0.782609 0.782609 dddaa4d
- 14 157998181 Total 0.782609 0.782609 0
15 40404 102010 | KI3857778 EMISID LastName  First Name  Middle Name 40404 FTED-001 FTOOOO FTE Detail OPDD 07/01/2017 12/31/2500 1 1 333333
EMIS
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- Undo Subtotals

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW  VIEW

mleln 3 G f%@“"‘“'”"‘ Hil Yy eE M £ B B =5 8 49 &

Elp thes i
From From From FromOther  Existing SR | xy Son | P o PPV | Tatio. Fash Mamove  Outs Conaolidehs Whet Reletionships | Grosip Ungroup Subtotl |
Access Web Tet Sources>  Connections  All= o Bdit Links W advanced  Columns  Fill  Duplicates Validation = Analysis * - -
Get External Data Connections Sort & Filtet Data Tools Outline
a1 - > fe  ReTDESTIRN

Trooa s < o e+« | Toundo subtotals select “Subtotal”
and then “Remove All”

o

Ry

T (s O




Quick Check

Subtotaling the FTE Detail
Report provides a format for
easier analysis of the data.
Since many students have
multiple FTEs calculated,
using Excel to sum by student
will allow the detail to be
available while providing

subtotals below each student.

e Are there students with Adjusted or
Special Education FTEs that are less
than the Original FTE?

* Are you using this report with your FTE
Adjustment report to identify reasons
for the adjustments?

* Are you saving your reports between
reviews?

EMIS

Alliance



FTE Detail Report PivotTable
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| FTE Detail Report PivotTable

i

. Create a PivotTable in an FTE Detail Report

l HOME  INSERT o PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW
|!
From the Insert Tab,
Tables Illustrations Add-ins Select llPiVOtTa ble”
Al v frx | o0.979as3
|
\ L]
o+« w_w o _e o - - |Onthe Create PivotTabl
---------------------------------------------------------------------- n the Create PivotTable
e “ ”
LEVEL 2 RESULT | Create PivotTable L2 S st From pt ) Se eCt
RECTYPE RESULT CODE | . . e
1 [LEAIRN CODE  CODE DESCR || CN°°sethe datathatyouwantto analyze LEGALDITIME 1 1Pd
| 68| 40404 FTED-001 FTO000 FTEDetd| & 2¢lectatableorrange _ |} 40404 100 -
| 69 40404 FTED-001 FTO000 FTE Det Table/Range: ‘(FTED-001) FTE Detail046623-201"ISAS1:SAL: |=8: : 40404 100 -
70 | 111111 FTED-001 FTO000 FTE Det Ase Aivexter cala Source 444444 100 -

l 71 40404 FTED-001 FTO000 FTE Det 40404

5? 72 40404 FTED-001 FTO000 FTE Det Connection name : 40404 1
73 40404 FTED-001 FTO000 FTE Det Choose where you want the PivotTable report to be placed 333333

74 40404 FTED-001 FTO000 FTEDeta| @ New Worksheet 333 100 -
75 40404 FTED-001 FTO000 FTE Deta) Existing Worksheet 100 -
76 40404 FTED-001 FTO000 FTE Deta Location: 100 -

77 40404 FTED-001 FTO000 FTE Detg
78 40404 FTED-001 FTO000 FTE Det
79 40404 FTED-001 FTO000 FTE Deta
80 40404 FTED-001 FTO000 FTE Deta

Choose whether you want to analyze multiple tables
Add this data to the Data Model

[ OK ][ Cancel ]

EMIS
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: PivotTable Fields

SochObBERELLEE D ®wons

To build a report, choose

INSERT

fields from the PivatTable
Field List

Sheetl

FT

PAGE LAYOUT FORMULAS DATA REVIEW

VIEW
=

p— ] = + |-
T > fx [ ? -
I i Refresh Change Data  Clear Select Move  Fields, Items PivotC ™ Field  +/- Field
T f b - - Phvo bl B Sets - P k List Buttons Headers
f.t'
k N F

PivotTable Fields are available to
select to set up the PivotTable

When inserting a PivotTable,
a new tab is opened

ED-001) FTE Detald46623-20

EMIS
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: Select PivotTable Fields

PivotTable Fields X

Choose fields to add to report:

.| |Click and Drag

RESULT CODE DESCR
v| FTEFUND PTTRN CODE

ENRL START DATE H 1

ENRL END DATE Ie S I nto t e
7| ORIG FTE P
/| ADJSTD FTE N

7| ADJSTD SPECED CAT FTE T
LEGAL DIST OF RES IRN IVO a e
STDNT PCT OF TIME

! SENT REASON 1
SENT REASON 1 PCT
. SENT REASON 2
| SENT REASON 2 PCT
STATE EQUIV GRADE LEVEL CODE
DISAB CNDTN CODE

Drag fields between areas below:

Move Up
FILTERS
Move to Beginning
Move to Report Filter
Move to Row Labels
Move to Column Labels
ROWS

FTE FUND X Remove Field

FTEINCL 1 i,() Value Field Settings...

SPECED CAT CODE

Drag fields between areas below:

For Rows select:
“| FTE FUND PTTRN CODE

FILTERS

Valgles

Defer Layout Update

Count of ADJ...

/

v

Select the “Count” of
ADJSTD SPECED CAT FTE,
then in the menu select
“Value Field Settings”

FTE INCL CODE

wwor- sesos - | FOr Values select:
ORIG FTE
ADIJSTD FTE

Count of ADJ... ¥

Defer Layout Update

T ~ | ADJSTD SPECED CAT FTE

In the Value Field
Settings prompt, select
“Sum” and “OK”

Value Field Settings L2 EE

Source Name: ADJSTD SPECED CAT FTE
Custom Name:  Sum of ADJSTD SPECED CAT FTE

Summarize Values By | Show Values As

Summarize value field by

Choose the type of calcul,
data from the selectegffeld

that you want to use to summarize

Number Format | OK Cancel

~ EMIS
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" PivotTable

Row Labels ~ Sum of ORIG FTE Sum of ADJSTD FTE Sum of ADJSTD SPECED CAT FTE

+COMM
- NFRG
NONE
- OPDD
FULL
NONE
- OPID
PART
- PSET
FULL
- PSRD
FULL
- RGJV
FULL
PART
- SPCO
FULL
Grand Total

1.901528 1.901528
9.714285 <« 0
9.714285 0
159.502042 15.502042 2
3.558118 3.558118
15.943924 15.943924 2
1 1
1 1
0.612676 0.612676 0.612676
0.612676 0.612676 0.612676
0.623377 0.387324 0.387324
0.623377 0.387324 0.387324
48.343595 48.325029 3
42.343595 42.325029 3
6 6
1 1 1
1 1 1
82.697503 72.728599 7

Click on specific values
to drill into the detailed
data

When drilling on a number
within the PivotTable, all
of the data within the row
will appear

EMIS
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~ Detailed Data

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW ViEW DESIGN
o X ¥ .
y bl Calibri Ju eA A =8 & BowepTen Genesal

b @ Copy -

aste - . v B - “= ¥ - 9

- v Format Painter B Iy ? A S b2

% Font 3 Angnment Number

Al v Je  RPTDESTIRN

E

Conditional Format as
Formatting~  Table ~

- | Detailed data will

. |appear in a new tab

2 40404 101010 F AFS33018!EMISID LastName FirstName Middle Name 40404 FTED-001
3 40404 101010 F VQS565973 EMISID  Last Name  First Name  Middle Name 40404 FTED-001
: 40404 101010 F VQIB4649EMISID LastName  First Name Middle Name 40404 FTED-001
S 40404 101010 F AF979437:EMISID LastName FirstName Middle Name 40404 FTED-001
6 40404 101010 F VO357639EMISID LastName FirstName Middle Name 40404 FTED-001
7 40404 101010 F NKS33773 EMISID LastName  FirstName  Middle Name 40404 FTED-001
8 40404 101010 F NFIS769LEMISID LastName First Name Middle Name 40404 FTED-001
9 40404 101010 F ND376667EMISID LastName  FirstName  Middle Name 40404 FTED-001
10 40404 101010 F LE400I829EMISID LastName  First Name  Middle Name 40404 FTED-001
11 40404 101010 F KS5651591EMISID  LastName  FirstName  Middle Name 40404 FTED-001
12 40404 101010 F KP72663MEMISID LastName FirstName Middle Name 40404 FTED-001
13

14

15

16

ED-001) FTE Detail046623-201 *

Sheet2 | Sheetl

Hrosch, Tammy

Normal Bad Good Neutral Calculation u 2 Autosum - ‘Z\\v ﬁ
. « {3 Finn-
Input Note Insert Delete Format X Sort & Find &
- - - & Clear~ Filter = Select ~
Styles elis Editing

FT0000 FTE Detail NFRG 08/01/2017 12/31/2500 1 0
FT0000 FTE Detail NFRG 08/29/2017 12/31/2500 1 0
FT0000 FTE Detail NFRG 08/01/2017 12/31/2500 1 0
FT0000 FTE Detail NFRG 07/01/2017 12/11/2017 0.376623 0
FT0000 FTE Detall NFRG 08/01/2017 12/31/2500 1 0
FT0000 FTE Detail NFRG 08/01/2017 12/31/2500 1 0
FT0000 FTE Detail NFRG 07/01/2017 12/31/2500 1 0
FT0000 FTE Detail NFRG 08/01/2017 11/27/2017 0.337662 0
FT0000 FTE Detail NFRG 08/01/2017 12/31/2500 1 0
FT0000 £TE Detail NFRG 08/01/2017 12/31/2500 1 0
FT0000 FTE Detall NFRG 08/01/2017 12/31/2500 1 0

When finished, the new tab
can be deleted or just go
back to the PivotTable on
Sheetl to drill again

Alliance



Quick Check

PivotTables can provide a
summary of a large amount of
data that allows the data to
be analyzed in smaller
sections. Try using
Recommended PivotTables to
think of different ways to
analyze your data.

* Are you able to create a PivotTable and
drill into the detailed data?

* What other fields in the FTE Report
could be brought into a PivotTable?

* Can you think of other reports that
could be analyzed using PivotTables?

EMIS
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} Summary

|

* Basic Excel techniques can be very useful when
troubleshooting

 EMIS data in the Student Information System
* EMIS reports
* preview/review files

* These techniques should be part of your everyday practices



Resources

* Microsoft Excel Help within Excel “?” Articles and Videos
* Google it

* Microsoft Excel Classes

* Your ITC



Questions?




